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Overview of Multi-CAD   

About Theorem   

Theorem Solutions is a world leader in the field of 

Engineering Data Services and Solutions. This 

leadership position stems from the quality of our 

technology and the people in the company. Quality 

comes not only from the skills and commitment of 

our staff, but also from the vigorous industrial use of 

our technology & services by world leading customers.    

We are proud that the vast majority of the world's leading Automotive, Aerospace, Defense, 

Power Generation and Transportation companies and their Supply chains use our products 

and services daily. Working closely with our customers, to both fully understand their 

requirements and feed their input into our development processes has significantly 

contributed to our technology and industry knowledge.    

Theorem Solutions is an independent UK headquartered company incorporated in 1990, 

with sales and support offices in the UK and USA. Theorem has strong relationships with the 

major CAD and PLM vendors, including; Autodesk, Dassault Systemes, ICEM Technologies (a 

Dassault company), PTC, SolidWorks, Spatial Technology and Siemens PLM Software. These 

relationships enable us to deliver best in class services and solutions to engineering 

companies worldwide.    
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Theorem’s 

Product Suite 

Theorem have 3 main 

Product brands. 

These are: 

 

 

 

 

 

 

 

 

 

 

 

TRANSLATE 
 

Direct translation of 3D data to or from an alternate 

CAD, Visualization or Standards Based format. 

 

 

See our website for more detail. 

 

 

 

  

 
 

 

PUBLISH 
 

The creation of documents enriched with 3D content 

 

 

 

See our website for more detail. 

  

  

 

 

VISUALIZE 
 

Visualization for Augmented (AR), Mixed (MR) and 

Virtual (VR) Reality applications 

 

 

See our website for more detail. 

https://www.theorem.com/translate
http://www.theorem.com/publish
http://www.theorem.com/visualize
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The CATIA V5 Multi-CAD Bi-directional CREO Translator   

The CATIA V5 Multi-CAD to Creo Parametric (CREO) translator may be installed on a number 

of machines each accessing a central network floating license.   

   

The CATIA V5 Multi-CAD to CREO Translator is a bi-directional direct  

database converter between the Dassault Systemes CATIA V5 Modelling Application and the 

CREO Modelling Application.    

   

It enables the user to convert all forms of 3D Mechanical Design Geometry and Assembly 

data, together with system defined attribute information, colour information, between 

these two systems. This product is designed for companies who require a method of 

collaboration and communication between OEMs and their customers or suppliers.    

   

The translator can be invoked in either an interactive or batch mode with the command line 

interface allowing the conversion process to be integrated into any process oriented 

operation. Alternatively the conversion process may be operated by using the Theorem 

Unified Interface.   

   

Primary Product Features   

• Converts all types of geometry, wire frame, surfaces, trimmed surfaces (faces) and 

solid models.    

• Converts assembly structure between both systems.    

• Converts attribute data including colour and layer information.    

• Converts File Properties.   

• Integrated with the CATIA V5 installation.    

• The conversion process can be run Interactively, Batch Mode or using the new 

Unified Interface    

• Command line interface allows process integration into any workflow or automated 

process.    

• Uses the Dassault Systems CATIA V5 Multi-CAD API and the Creo Parametric API to 

read and write the respective data formats.    

• When writing CATIA V5 data the user is able to configure the derived geometry to be 

created in either VISU (CGR), VISU + Snap (CGR + Canonical data to aid positioning) 

or CATPart format data.    

   

   

  

Primary Product Benefits?   

• Being a direct database converter all pre and post processing is eliminated, saving 

time.    
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• Reduce costs due to processing time and increase overall conversion success levels 

by filtering input data and focusing the conversion to only those elements required.    

• Reduce costs and risks associated to accessing the wrong version of data by 

integrating the conversion process into a related business processes.    

• With over 20 years of industrial use Theorem translation products robustness and 

quality is well proven, reducing your business risk.   

   

   

   

This document will focus specifically on guidance for the use of the Multi-CAD for CATIA V5 – 

CREO product.  For information regarding any of Theorem’s product ranges please contact 

sales@theorem.com   
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Getting Started   

Documentation   
A copy of the latest documentation for all Theorem Solutions products can be found on our 

web site at:   

http://www.theorem.com/Documentation   

   

For each of the Multi-CAD related products there is a specific link that provides user 

documentation in the form of PDF and Tutorials. For this product navigate to the Multi-CAD 

CATIA V5 – CREO section.   

   

Installation Media   
The latest copy of each release is specified in the Product Release Document associated with 

each specific release. A copy of the current product release notes can be found on the 

Theorem Solutions web site at:   

 http://www.theorem.com/Product-Release-Notes   

   

Simply download the Product Release Document and select the hyperlink within the 

document to download the installation media.   

   

For Multi-CAD related products the installation requires 3 CD’s to be installed   

1. The Theorem Solution TXX Multi-CAD Platform CD   

2. The Theorem Solutions Unified Interface CD   

3. The Theorem Solutions Multi-CAD CATIA V5 – CREO CD   

   

Alternatively, you can request a copies of the software to be shipped on a physical CD media. 

Please contact your sales representative mailto:sales@theorem.com to arrange the 

shipment of the physical CD media.   

   

Software and License Installation   

The software installation and License configuration process is fully defined in a separate 

document. Please refer to the document titled “CATIAV5 Multi-CAD Installation Instructions” 

for complete installation instructions   

  

Running the Product   

Once configured and licensed, the product will be ready to be used.   

Prior to initially using the translator CATIA V5 must have been launched at least once to 

allow the selection of the CATIA V5 licenses to be recorded in the users CATSettings folder.  

http://www.theorem.com/Documentation
http://www.theorem.com/Documentation
http://www.theorem.com/Documentation
http://www.theorem.com/Product-Release-Notes
http://www.theorem.com/Product-Release-Notes
http://www.theorem.com/Product-Release-Notes
http://www.theorem.com/Product-Release-Notes
http://www.theorem.com/Product-Release-Notes
http://www.theorem.com/Product-Release-Notes
http://www.theorem.com/Product-Release-Notes
http://www.theorem.com/Product-Release-Notes
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Once the CATSettings are generated the translator will be able to be executed either 

internally or externally to CATIA V5 until the CATSettings are removed. Therefore if you 

operate a procedure that programmatically generates the users CATSettings this 

requirement to maintain a reference to existing CATSettings must be considered when using 

the product in batch external to the CATIA V5 application.      

All specific CATIA V5 environment configuration details are documented in Appendix A of 

this document.   

  

Methods of Invoking the CADverter   

The CATIA V5 <> CREO MultiCAD CADverters can be invoked in a variety of methods, 

these include;   

• Interactively from within CATIA V5 using standard CATIA V5 menu option 

“Insert Existing Component”  

• From the Theorem Graphical User Interface (GUI)   

• From a command prompt window using the command line. This mechanism 

can be used to automate the translation process as part of any automated 

workflow.    

  

Interactive usage within CATIA V5   

Starting CATIA V5   
In order to use the Theorem CADverter products interactively within the CATIA 

application, you must start CATIA V5 with the correct CATEnv environment settings. 

A desktop icon and a start menu item are both able to be created during the 

installation process to achieve this.   

   

The desktop icon is labelled “Theorem Multi-CAD CREO CATIAV5Rnn” (where nn is 

the release version (26 for V5-6R2016, 27 for V5-6R2017, 28 for V5-6R2018).   

   

The Start menu item is located under the “Start + All programs + CATIA” folder and is 

also named “Theorem Multi-CAD CREO CATIAV5Rnn”.   

   

Using “Insert Existing Component”   
   

The CATIA V5 Multi-CAD architecture allows you to invoke the Theorem CREO to 

V5 Multi-CAD translator to import components or assemblies into an active CATIA 

V5 CATProduct by using the “Insert > Existing Component…” menu item.   Also note 

that the CATIA associativity (Update Status Checker) mechanism can invoke the 

translator execution.   
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In order for the Theorem translator to be invoked from within CATIA V5, the 

setting of the “Preferred Conversion Technology”  must be set to “Indirect” on the 

CATIA V5 Tools > Options > Compatibility > “External Formats” option page. (See 

section - Setting Conversion Options in CATIA V5)   

   

Note that this option page is only available if the TXX-THEOREM-MULTICAx 

GATEWAY (Theorem Partner) license is available which is provided by the Theorem 

license   

manager. Please see the installation document named “CATIA V5 

MultiCAD_Installation_Instructions.pdf” for details.   

   

There are some extra conversion options available to the Theorem User Interface 

that are not presented on the CATIA V5 External Formats options page.    

   

On invoking the “Insert Existing Component…” command in CATIA V5, and selecting 

a product node for the ‘insert’ operation, you will see the following file selector.    

   

Note: CREO files may contain a version number at the end of the file name. (e.g.: 

partname.prt.10 ) Therefore this is addressed by adding an extra filter to the file 

selector menu.   
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The translation will now proceed and the CATIA V5 representation of the CREO 

assembly/components will be incorporated in the active CATProduct.   

   

It is worth noting here that CATIA launches and manages a conversion sub-process 

that feeds the option page settings into the Theorem Multi-CAD translator via a   

temporary file named %CATTemp%\ProEToNavConfigs.txt   

This is referenced using the ‘–c <config_file>’ command line option.    

   

The Theorem User Interface allows you to select a CATIA generated configuration 

file as described above, but if none is selected, a default configuration file installed 

with the Theorem software under %TS_INST%\data\proe\ProEToNavConfigs.txt will 

be used. For further information on the CATIA V5 Multi-CAD integration methods 

and commands see the CATIA Infrastructure Documentation.   

   

The Theorem CREO to V5 Multi-CAD translator is also invoked when the CATIA 

“Update Status Checker” command determines that a CREO part file that was 

previously inserted using “Insert Existing Component” has been subsequently 

modified outside of the CATIA environment.   
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For further information on the usage of the CATIA commands “Insert Existing Component” 

and “Update Status Checker”, consult the CATIA Documentation under headings:   

•  Mechanical Design → Assembly Design •  

   Here you will find topics  o “Insert an Existing  

Component”  o “User Tasks” → “Updating an  

Assembly”   

   

Visualizing Inserted Annotations   
It should be noted that when you perform the “Insert Existing Component” command 

with a CREO file containing PMI data, you must perform the following operations to 

visualise it if the Link Mode used is ‘Visu’ or Visu Snap’   

• Activate a workbench supporting FTA operations such as with menu item 

“Start > Mechanical Design > Product Functional Tolerancing & Annotation”.   

• Use menu “Insert > Visualization > List Annotation Set Switch On/Switch Off”   

• Enable the listed Annotation Sets and apply the change.   

   

CREO to CATIA V5 MultiCAD Usage   

Setting Conversion Options in CATIA   

If you have the TXX-THEOREM-MULTICAx license, the following categories of options 

will be visible from the CATIA menu - Tools > Options on the Compatibility “External 

Formats” page   

 Visu Format Unit    
 Preferred Conversion Technology   
 Link Mode    

 Preferred Translation Mode   

 Others    

 Output of generated data    

 Ideas  

  ProEngineer      

Some of these settings are accessible to the Theorem CATIA V5 to CREO Multi-CAD  
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translator when it is run in both interactive and command line (batch) mode.   

   

   

 

  Millimeters  per unit   

The conversion of units from  CREO  parts is incorporated into the Theorem    

CADverter, so this value should always be set to 1.00   

   

Preferred Conversion Technology   

   

    

    

Visu    Format       Unit       
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Indirect   

This parameter determines that the 3rd party Theorem converters will be used in 

conversion operations.   

Direct   

This parameter determines that the Dassault Systemes converters will be used in 

conversion operations.   

   

Link Mode   

   

Visu   

Tessellated data.   

By default, this option is activated.   

   

Visu Snap   

Selecting this option forces the processing of CREO precise BREP geometry to 

generate a CATIA V5 CGR output. In addition canonical shape properties are also 

generated in the CGR file. Consequently the CGR data resulting from importing 

CREO will have additional geometry snapping capabilities. After selecting this 

option, this message appears: "Please, restart session to take modifications into 

account".   

   

CATPart   
This option causes the import of exact/brep geometry from the CREO file to 

be created in CATPart form.   

Preferred Translation Mode   

   

Selecting this option controls if links will be retained between the source CREO files 

which are imported, and the resulting CATIA files generated. In Multicad mode, links 

are retained and modifications are locked, in Translator mode, links are not retained 

and modifications are allowed.   

Others   

Save Coorsys in Cgr   

This option saves the CREO PMI co-ordinate system data into the derived CGR 

representation when Visu output is selected. Note this feature would also 

require the 3D Annotation setting to be selected to create the required 

output.    

3D Annotation   
This parameter determines whether 3D annotation data, referred to as “PMI” 

data in CREO, will be imported.    

(Note, requires one of the following licenses):   
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CATIA: FT1.prd or FTA.prd    

ENOVIA: DT1.prd    

DELMIA: MTR.prd or MFT.prd   

   

Output of generated data   

   

Output Path   

Setting the Output Path location enables you to customize the folder location 

that is used when writing the derived CATIA V5 generated data. It specifies 

the location where CGR, CATPart and CATProducts will be generated.   

      

ProEngineer   

   
Quilts Read   

Enable the reading of Quilts or Surfaces from Creo.   

  Simplified Representation   

Specify which Simplified Representation is to be read from Creo.   

  Instance Name   

If the file to be translated contains a “Family Table” this option allows the user 

to specify which “Instance” is to be processed from the Family Table.   

The CREO to CATIA V5 Multi-CAD options file   

There are some extra conversion options available to the Theorem CADverter GUI 

that are not presented to the user on the CATIA External Formats options page.  A 

mechanism to allow you to specify additional options to the CREO to V5 Multi-CAD 

translator is provided via a text file that the translator reads during the conversion 

process.   

The default location of this options file is defined in the %TS_INST%\bin\TheoremProps.txt 

file by the setting:   

Theorem. ProeServerCfile=%TS_INST%\\data\\proe\\proe_xcad_opts.txt   

   

This text file can be edited to contain any of the following command line options on 

a separate line:-  info   

Outputs extra processing information to log files.   

debug   

Outputs extra debugging information to log files help diagnose problems.   



 

  

Multi   -   CAD v23.3   for CATIA V5    -   
    CREO   

    

15     |    P   a   g   e           ©Theorem Solutions 2020     

surf_to_nurbs   

Read surfaces in NURBS form, rather than the default analytic 

forms (cylinder, cone, torus etc.).   

edge_to_nurbs     

Read edge curves in NURBS form, rather than the default analytic 

forms (conics).  no_check_geom   

Disable solid geometry checking during CREO read operations. 

Possibly improve throughput by allowing the write of geometry which 

may not pass the geometry checks.  no_datum_curves   

Disable the processing of Datum Curves   

disable_default_colours   

Disable applying default colours to un-coloured entities.   process_hidden_geom   

Process all geometry, including hidden layers.   

read_pmi   

Process PMI data.   

read_assy_pmi   

Process PMI found at the assembly level.   

write_stroked_pmi   

Causes PMI information to be stored in stroked(rendered) form as required 

by MultiCAD.   

The CREO to V5 Progress and Log File Outputs   

The CREO to CATIA V5 XCAD process log and error messages are recorded in a ‘.log’ 

file located in the CATIA CATReport directory. A process summary file is also 

produced here which contains the completion status of the conversion. These files 

are named after the selected input file name. E.g. if the file tea.prt were selected,   

the log and summary file names would be %CATReport%\tea.log  

and %CATReport%\tea.log.summary.   

If the CREO to CATIA V5 XCAD process is run using the CADVerter GUI or using the 

command line option ‘progress_file’ <name>, the log file output will honour this name, and 

the summary file will be named similarly with the suffix ‘.summary’.    

The V5 to CREO Progress and Log File Outputs   

The CATIA V5 XCAD to CREO process log and error messages are recorded in a ‘.log’ 

file located in the CATIA CATReport directory. The file is named after the selected 

output file name. E.g. if the file Mypart were selected, the log file names would be 

%CATReport%\Mypart.log and %CATReport%\Mypart.log.summary.   

If the CATIA V5 XCAD to CREO process is run using the CADVerter GUI or using the 

command line option ‘progress_file’ <name>, the process log and error messages will 
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be output to the specified name, and the summary file will also be named after this 

name with the suffix ‘.   

   

        

Using the Theorem User Interface   

Default Translations   

Default Translation – via the Unified Interface   

The Unified Interface can be started via the Start Menu – if a shortcut was added during installation.   

Alternatively, the Unified Interface can be run via a Windows Explorer selection in:   

<UI_installation_directory>\bin\Unified_Interface.cmd   

The following interface will be launched:   

   

   

The default layout is split into 4 primary areas, which can be altered to the users prefer:   

 

F   ile    

Browser     

Active    

Configurations     

Output    

Logs     

Translation    

Activity     
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The simplest way to translate from CATIA V5 or CREO is to drag a file from the file Browser Pane on 

to the Active Configurations for the translation you require.      

   

On completion, the Unified Interface will display the activity information and details from the 

log file created during the translation, if requested, in the Translation Activity and Output Log 

panes, respectively.   

The generated output data can be located by selecting the translation from the Activity pane   

 

Default Translation – via the Command Line   

Running a translation via the command line can be carried out via the cad_run.cmd file located 

in the <installation_directory>\bin directory. The format of the command is as follows when 

translating from CATIA V5 to CREO:  

<Translator_installation_directory>\bin\catia5r[XX]xcad_protkcr(X).cmd  <input_file>   <output_file>   

and opening the output folder:     
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The format of the command is as follows when translating from CREO to CATIA V5:  

<Translator_installation_directory>\bin\ protkcr(X)_catia5r[XX]xcad.cmd <input_file>  <output_file>   

(Notes!    

Replace the [XX] with the version of CATIA V5 you are using. E.g. for CATIA V5R26, change to 

catia5r26xcad   

Replace the (X) with the version of CREO. E.g. for CREO3, protkcr3):   

   

   

The example above will translate a CATIA V5 sample file provided within the installation and produce the 

following screen output:   

     

The file will be output to the target location.  In this case:   

C:\Temp\pump_assy.asm   
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Translator Customization   

The Theorem translator allows the information that is read from the source system and written to 

the target system to be tailored via a set of user specified arguments.  Commonly used 

arguments are supported via the Unified Interface, with Advanced Arguments being described 

within this document for use in the Unified Interface or via the Command Line invocation.   

Common Options for CATIA V5 to CREO   
Within the Configuration Manager pane of the Unified Interface, arguments that can be specified when 

publishing CATIA V5 data into CREO are grouped into 3 areas:   

• CATIA V5 Read  – Those arguments that affect how data is read from CATIA V5   

• CREO Write     – Those arguments that affect how the data is written to CREO   

• General    – Those arguments that are common to ALL Publishing activities     regardless of 

source data   

   

CATIA V5 Read Arguments   

The image below shows the CATIA V5 Read arguments that are available, with their default settings:   

   

Each of these options is described below:   

Option  Description   

Preferred Read Data Type   Allows the user to specify Exact or Tessellated read. (Default is 

Exact)   

•  Command Line Syntax o read_tess (to enable 

Tessellated) o Exact as is Default and has no 

argument   
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Read 3D Annotations   Read 3D PMI. (Default is Off)   

•  Command Line Syntax o read_pmi   

Disable Points   Disable the processing of standalone Points. (Default is Off)   

•  Command Line Syntax o disable_points   

Disable Axis Systems   Disable the processing of Axis Systems. (Default is Off)   

•  Command Line Syntax o disable_axes   

Disable Wireframe   Disable the processing of standalone Wireframe. (Default is 

Off)   

•  Command Line Syntax o disable_wireframe   

Disable Surfaces   Disable the processing of standalone Surfaces. (Default is Off)   

•  Command Line Syntax o disable_surfaces   

Disable Solids   Disable the processing of solids. (Default is Off)   

•  Command Line Syntax o  

disable_solids   

Export Body Names   Create Body Named Containers. (Default is Off)   

•  Command Line Syntax o body_names   

Property Mapping File   This is a file containing a list of CAD properties and 

information on how they are mapped to the CREO file. (See 

section  Property Mapping Files) .   

•  Command Line Syntax o cad_prop_map_file  

<path\filename>   

   

CREO Write Arguments   

The image below shows the Write CREO arguments that are available, with their default settings:   

   
This option is described below:    
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Option  Description   

Simplify Geometry   Attempt to write Analytical Geometry where possible (Default 

is Off)   

•  Command Line Syntax o  

simplify   

Use existing Assembly   

Parts   

If Output Folder already contains output Files of the same 

name, do not Overwrite those Files (Default is Off)   

•  Command Line Syntax o use_parts   

   

CATIA V5 to CREO General Arguments    

The image below shows the General arguments that are available, with their default settings:   

   

This option is described below:    

Option  Description   

Mass Properties   

   

   

Allows Mass Property information to be calculated in the 

source and target data and writes this information in the log 

file. (Default is Off)   

•  Command Line Syntax:   

o  mprops   

Advanced   Allows any of the Command Line Advanced arguments 

documented to be passed to the Unified Interface invocation.    

   

Common Options for CREO to CATIA V5   
Within the Configuration Manager pane of the Unified Interface, arguments that can be specified when 

publishing CREO data into CATIA V5 are grouped into 3 areas:   

• CREO Read   – Those arguments that affect how data is read from CREO   

• CATIA V5 Write  – Those arguments that affect how the data is written to CREO   

• General    – Those arguments that are common to ALL Publishing activities     regardless of 

source data   

   

CREO Read Arguments   

The image below shows the CREO Read arguments that are available, with their default settings:   
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Each of these options is described below.   

   

Option  Description   

Transfer Solids   Solids will be converted (Default is on)    

•  Command Line Syntax:   

o no_solids ( disable processing of Solids)   

Transfer Quilts   Quilts will be converted (Default is on)    

•  Command Line Syntax:   

o no_quilts ( disable processing of Quilts)   

Transfer Datum Curves   Datum Curves (Wireframe) will be converted (Default is on)    

•  Command Line Syntax:   

o no_datum_curves ( disable processing of Datum  

Curves)   

Transfer Datum Surfaces   Datum Surfaces  will be converted (Default is on)    

•  Command Line Syntax:   

o no_datum_surfaces ( disable processing of Datum  

Surfaces)   

Retain Assembly   

Structure   

Maintain assembly structure in target file (Default is on)   

•  Command Line Syntax:   

o ditto (default – maintain structure) o noditto 

(no structure, single part created)   

Read Blanked Layers   Process data As Saved, or read data from All Layers (Default is off 

or As Saved)   

•  Command Line Syntax:   

o Layer ALL (enables all layers)   

   

CATIA V5 Write Arguments   

The image below shows the CATIA V5 Write arguments that are available, with their default settings:   
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Each of these options is described below:   

Option  Description   

Config File   Specify Advanced Arguments in a Config File.   

•  Command Line Syntax o  

-c  <path\filename>   

Property Mapping File   Specify a file which allows filtering of Detail user attributes.    

•  Command Line Syntax o  

-c  <path\filename>   

     

CREO to CATIA V5 General Arguments   

The image below shows the General arguments that are available, with their default settings:   

   

   

The option is described below:   

Option  Description   

Advanced   Allows any of the Command Line Advanced arguments 

documented below to be passed to the Unified Interface 

invocation   

   

   

Appendix A – CATIA V5 Configuration   

Introduction   
This Appendix details how to define and configure the CATIA V5 and Theorem environment to work 

together.    

Conventions   
Release of CATIA V5    
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To indicate a release of CATIA V5 the notation <XX> shall be used. This needs to be replaced with the 

specific release to be used i.e. 18, 19, 20, 21, 22 or 23.    

Platform specific directory   

Within the installation directory of CATIA V5 there is a platform specific directory i.e. win_b64. This 

directory shall be referred to as <OSDS> in this Appendix.   

Theorem Installation directory   

The Theorem translator installation directory is set at installation time in the translator ts_env.bat 

file. This directory shall be noted as <%TS_INST%> in this Appendix.   

CATIA V5 Installation Directory    
Upon installation of a CATIA V5 product the user will be asked to specify the installation directory. This 

is the directory which contains the platform specific <OSDS> directory.    

Having selected the CATIA V5 installation directory via the browse button, the installation 

process will record the location of the CATIA V5 installation directory in the ts_env.bat file. This 

file is located in the Theorem translator installation directory. If the location of CATIA V5 

subsequently changes, the translator can be guided to the changed location by modifying this 

file using a text editor to modify the ts_env.bat that is located in the translator installation 

directory.   

For CATIA V5 R21 and R22 a choice is available of using the older LUM Legacy licensing system or 

the new Dassault Licensing.  To enable this enter LEGACY in the DSLICENSING option.    

If no entry is included for DSLICENSING a warning dialog will be displayed which warns of the empty field. 

Selecting Yes to continue will allow the installation to continue.   

   

Running CATIA V5 Translators    
Before running the translator the user must run CATIA V5 interactively at least once to configure 

the CATIA V5 environment and license settings. This can be achieved by running the 

catia5r<XX>_start script as follows:   
%TS_INST%\bin\catia5r<XX>_start.cmd   

Once CATIA has been run the Translator can run as described in the relevant product User Guide.   

CATIA V5 Environment DIRENV & ENV    
The default location for CATIA V5 to store its global environment files is in the global directory:   

Windows XP:   

C:\Documents and Settings\All Users\Application Data\DassaultSystemes\CATEnv   

Windows 7 & 8:   

C:\ProgramData\DassaultSystemes\CATEnv   
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Or   

%APPDATA%\CATEnv    

You can find this location by running:   

%CATIAV5_INST%\<OSDS>\code\bin\setcatenv -h   

The environment files are named in the form CATIA.V5RN.B<XX>.txt   

If when installing CATIA V5 the default environment file location was replaced with another 

location then this location needs to be indicated to the Translator by defining in the ts_env.bat the 

environment variable CATIAV5_DIRENV:   

set CATIAV5_DIRENV=/some/directory   

If the Theorem installation is needed to support multiple releases of CATIA. Then the user can define 

release specific locations using:   

set CATIAV5R<XX>_DIRENV=/some/directory   

The Theorem translator will attempts to create its own environment file called  

TheoremCatia5R<XX>.txt. The user must therefore have write permission to the CATEnv 

directory. If this is not possible an existing environment file can be specified using the variable 

CATIAV5_ENV. e.g.    

set CATIAV5_ENV=CATIA.V5R19.B19   

Note. the extension .txt is not required. The user can specify a release specific name using 

CATIAV5R<XX>_ENV e.g.    

set CATIAV5R19_ENV=CATIA.V5R19.B19   

Checking the CATIA V5 Environment    
A script is provided to check that the CATIA V5 environment is set up correctly. In a command window 

run the command script:   

%TS_INST%\bin\checkcatia5r<XX>env.cmd   

Checking the Theorem Shared Library    
A script is provided to ensure that the CATIA V5 environment is compatible with the Theorem shared 

library.  In a command window run the command script:   

%TS_INST%\bin\checkcatia5r<XX>cadverter.cmd   

A successful output is an indication that the location for CATIA V5 has been specified to the Theorem 

translator correctly and that the correct version of the Theorem CATIA V5 translator products have 

been installed.    

   

   


